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FPGA Potential

* Implementing computations in hardware can have
speed/energy advantages over software:
* Lithography simulation: 15x speed-up [Cong & Zhou,
TRETS09]

* Linear system solver: 2.2x speed-up, 5x more energy
efficient [Zhang, Betz, Rose, TRETS 12]

* Monte Carlo simulation for photodynamic therapy: 80x
faster, 45x more energy efficient [Lo et al., J. Biomed
Optics’09]

e Option pricing: 4.6x faster, 25x more energy efficient [Tse,
Thomas, Luk, TVLSI'12]
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Hardware Design is Difficult

* FPGA “success stories” are pervasive, yet the technology
remains inaccessible to software engineers

e Requires use of hardware description languages: Verilog and
VHDL

* Hardware design skills are rare:
e 10 software engineers for every hardware engineer*

N2

 Make hardware design easier for hardware engineers

* Allow software engineers to design hardware and reap
its energy/performance benefits

*Source: US Bureau of Labor Statistics, 2012



High-level synthesis (HLS) with
-PGAS

* Plays a central role, enabling the automatic
synthesis of high-level, untimed or partially timed
specifications (e.g. C or System C) to low-level cycle
accurate RTL specifications

* Target devices includes application-specific
integrated circuits (ASIC) or field-programmable
gate arrays (FPGAS)

* [t can be optimized taking into account the
performance, power, and cost requirements



High-level Synthesis Flow
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Scheduling

* How to assign the computations of a program into
the hardware time steps (clock cycles)?

* Must consider under given target clock period:

* Which operations can be scheduled in the same time
step?
* Which operations are dependent on others?



Schedule strategies

* As soon as possible (ASAP)
* As |ate as nossible (ALAP)

Control
Step ;\SAP
1
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6 f] 8 ;
9 10 4
)

(a) Sorted DFG (b) ASAP schedule

(b) ALAP schedule
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High-level Synthesis Flow
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Binding

* Assign (bind) each operation to a hardware
functional unit

e Example:

* LegUp uses bipartite matching-based binding [Huang
DAC’90] using the Hungarian Method (Polynomial order)

operations

edge costs

hardware functional units
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AutoESL and Xilinx C-to-FPGA
design flow
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Performance Feature: Loop
Pipelining

for (inti=0;1<N; I++)
sumfi]j=a+b+c+d
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Sequential Execution

Not efficient!

. . . ; « 3 Cycles/lteration
for (inti=0;i<N; i++) . Total Cycles: 3N
sumfij=a+b+c+d = SrEsr
« Adder Utilization: 33%

1. Sequential Execution

Cycles: 5 6 7 8 9

1 2 3 4
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Poop Pipelining

#pragma pipeline

for (inti=0;1<N;i++)
sum[ij=a+b+c+d

3. Parallel Execution : Loop pipelining

Cycles: 5

1 2 3. % 9. =

Steady-state

Ei

Efficient!

1 Cycles/Iteration
(steady-state)

Total Cycles: N+2
Adders: 3

Adder Utilization: 100%
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using

High-quality and rapid design

LS: Why?

* Embedded processors are in almost every SoC

* Huge silicon capacity requires a higher level of
abstraction

* With the HLS, the code density can be easily reduced by
7x-10x in C/C++

* Behavioral IP reuse improves design productivity

* Verification drives the acceptance of HLS
* It avoids slow and error-prone manually RTL cording

e Trend toward extensive use of accelerators and
heterogeneous SoCs



~aster Adoption of HLS Tools with
-PGAs: Why?

* Less pressure for formal verification

* |terations of the FPGA design can avoid huge
manufacturing costs

* |deal for platform-based synthesis
* Achieve higher quality of results (QoR)

* More pressure for time-to-market
* Designers may accept increased performance, power, or
cost in order to reduce design time

e Accelerated or reconfigurable computing calls for
C/C++ based compilation/synthesis to FPGAS



Overv

ew of HLS Tools

Status Compiler Owner License Input Output Year Domain TestBench | FP | FixP
eXCite Y Explorations | Commercial C VHDL/Verilog | 2001 All Yes No Yes
CoDeve- Impulse Commercial | Impulse-C v H.DL 2003 ! mage Yes Yes No
loper Accelerated Verilog Streaming

Catapult-C CaI)-SpItF) De.s,1gn Commercial C,{C++ VHDIITfVenlog 2004 All Yes No Yes

ystems SystemC SystemC
Cynthesizer FORTE Commercial SystemC Verilog 2004 All Yes Yes | Yes
Bluespec BlueSpec Inc. Commercial BSV SystemVerilog | 2007 All No No No
CHC Altium Commercial C subset VHDL/Verilog | 2008 All No Yes | Yes
;'Di CtoS Cadence Commercial TSIEI;[I?(I}E+ S\;ig;% 2008 All Oellllgu‘;;t‘:a le No Yes
- DK Dcmgn Mem?r Commercial | Handel-C VH.DL 2009 | Streaming No No Yes

Suite Graphics Verilog
GAUT U. Bretagne Academic C/IC++ VHDL 2010 DSP Yes No Yes
MaxCompiler Maxeler Commercial MaxJ RTL 2010 | DataFlow No Yes No
ROCCC Jacquard Comp. | Commercial C subset VHDL 2010 | Streaming No Yes No
Sy n[gmn)- Synopsys Commercial C/IC++ v HSDIIT,Nenlog 2010 All Yes No Yes

ystemC
wober: NEC Commercial | BDL \\:,gjl%i 2011 | Al yelel - yes | Yes
LegUp U. Toronto Academic C Verilog 2011 All Yes Yes No
Bambu PoliMi Academic C Verilog 2012 All Yes Yes No
DWARV TU. Delft Academic C subset VHDL 2012 All Yes Yes | Yes
VivadoHLS Xilinx Commercial C/C+ VHDWenlog 2013 All Yes Yes Yes

SystemC SystemC
Trident Los Alamos NL Academic C subset VHDL 2007 | Scientific No Yes No
< CHiMPS U. Washington Academic C VHDL 2008 All No No No
z Kiwi U. Cambridge Academic C# Verilog 2008 NET No No No
gcc2Zverilog [45] U. Korea Academic C Verilog 2011 All No No No
HerculeS Ajax Compiler | Commercial C/NAC VHDL 2012 All Yes Yes | Yes
Napa-C Sarnoff Corp. Academic C subset VHDL/Verilog | 1998 Loop No No No
DEFACTO U. South Cailf. Academic C RTL 1999 DSE No No No
- Garp U. Berkeley Academic C subset bitstream 2000 Loop No No No
Y MATCH U. Northwest Academic MATLAB VHDL 2000 Image No No No
k= PipeRench U.Carnegie M. Academic DIL bitstream 2000 Stream No No No
E SeaCucumber U. Brigham Y. Academic Java EDIF 2002 All No Yes | Yes
=« SA-C U. Colorado Academic SA-C VHDL 2003 Image No No No
SPARK U. Cal. Irvine Academic C VHDL 2003 Control No No No
AccelDSP Xilinx Commercial | MATLAB | VHDL/Verilog | 2006 DSP Yes Yes | Yes
C2H Altera Commercial C VHDL/Verilog | 2006 All No No No
CtoVerilog U. Haifa Academic C Verilog 2008 All No No No

J. Cong et. al, “A survey and evaluation of FPGA high-level synthesis tools,” IEEE Trans. on CAD, 20%5.




Productivity
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Code Size
RTL (Verilog) 4 gates/line

Behavioral C 28 gates/line

= 7X more productive
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RTL Expert v.s HLS Expert

SPHERE DECODER IMPLEMENTATION RESULTS

Metric RTL Expert | AutoPilot Expert | Difference (%)
Dev. time (man-weeks) 16.5 15 —9
LUTs 32708 29060 —11
Registers 44 885 31000 —31
DSP48s 225 201 —11

8K BRAMs 128 99 —26

8 x 8§ RVD-QRD IMPLEMENTATION RESULTS

Metric ETL Expert | AutoPilot Expert | AutoPilot Expert
Dev. time (man-weeks) 4.5 3 5

LUTs 5082 6344 3862
Registers 5699 5692 493]
DSP48s 30 46 30

18K BRAMs 19 19 19

J. Cong et. al, “High-level synthesis for FPGAs: From prototyping to deployment,” IEEE Trans. on CAD, 2011.
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Walk Through HLS Design



Vivado HLS Design Flow

* Design C/C++ code for your target specification in advance
N

* Create a new project

» Refactoring for HLS suitable C/C++ -

* High-level synthesis . [, ]

e RTL-C Co-verification (Optional)

* |P generation —
N

* Integrate HW on Vivado block diagram design \/I\/ADO?

* Design SW on XSDK

 Run on your FPGA board

Software Development Kit



Design a Specification by C/C++

* See, Github for lecture 9: float mult.c
{stdio. h>
<{stdlib.h>
ERROR_ THRESH:- 0, 1
void-float mult(float-a, -float-b, float-*c)

*¥C-=--a-%-b;

}

int-main(void)

[ -float:fres, fia, fib, fref, -err;
int-ec-=-0;

(unsigned-int-i
fia-=-(rand() %10
fib-=-(rand() % 100.0;
float mult(fia, -fib, -&fres);

fref-=fia * -fib;

err-=-fref---fres;
(-err-<-0)-err-*=--1,0;
printf("fia=}f fib=%f fres=Yf fref=%f", fia, -fib, fres, fref);
(-err-> ERROR THRESH) - {
ectt;
pri?tf(” ERROR¥n");

printf("¥n");

==-0) -printf(”"[Test -Passed]¥n”); printf(”"[Test -Failed]¥n”);




Create a New Project

* Windows: Start > All Programs > Xilinx Design Tools
> Vivado 2017.4 > Vivado HLS > Vivado HLS

e Linux (Ubuntu):
#tsource /opt/Xilinx/Vivado/2017.4/settings64.sh
#tvivado hls &



On the Vivado HLS Welcome Page

* In the Welcome Page, select "Create New Project”
to open the Project wizard.



On Proj

ect Configuration Page

* 3. Enter the project name as "lec 9"

e b. Enter t

ne project Location as "C:¥FPGA¥HLS"

(Windows), "/home/(usrname)/FPGA/HLS" (Ubuntu)
e . Click Next

/

Project Configuration

A f—," .
Create Vivado HLS project of selected type /

Projec

t name: | lec_@ |

Location: |C:¥FF‘GA¥HLS Browse...

Mext = Cancel




On an Add/Remove Files Dialog

* Enter the following information to specify the C design files:
* a. Click Add Files.
* b. Select "float__ mult.c" and click Open.

 c. Use Browse button to specify "float_mult" as the top-
level function.

e d. Click Next.

4 New Vivado HLS Project a >
Add/Remove Files S=n—
Add/remove C-based source files (design specification) IEV
Top Function: | float_mult | |Br0wse...|
Design Files
Mame CFLAGS Add Files...
float_mult.c New File...
Edit CFLAGS...
Remove
< Back Next > inish Cancel




Add/Remove C-based Testbench Files

* Click the Add Files button to include both test bench files
"float mult.c"

* Then, Click Next.

e Both C simulation and RTL co-simulation execute in
subdirectories of the solution.

/

Add/Remove Files -
Add/remowve C-based testbench files (design test) %E/
TestBench Files
Mame CFLAGS Add Files...
float_mult.c New File..
Add Folder..




Solution Configuration

* Accept the default solution name (solutionl), clock period
(10 ns), and clock uncertainty (defaults to 12.5% of the clock

period, when left blank/undefined)

* Click the part selection button to open the part selection
window

# Device Selection Dialeg

>

Select: g Boards

Filter

Product Category: | General Purpose v | Package: clg400
Family: zyng v | Speed grade: | -1
Sub-Family: Zy¥nyg v | Temp grade: | ¢

Reset All Filters

Search: + |

Part Family Package Speed SLICE  LUT FF DSP BRAM
@ xcT2020c1g400- 1 yng clgaon -1 13300 53200 106400 220 280

G xCT2014s5c 1 gA00-1 zyng clgaon -1 10150 40600 &1200 170 214
@xc?zﬂmclgtmDJ ¥ng clg400 -1 4400 17600 35200 &0 120
@ ¥ 7z007sclg400-1 yng clg400 -1 3600 14400 28800 66 100

Cacel




Cont'd

* Carefully Select Your FPGA on the Zybo!!

e From the list of available devices

e Click "OK", and click "Finish"

/

Solution Configuration

Create Vivade HLS solution for selected technology

h‘

Solution Mame: | solution

Clock

Period: |1EI | Uncertainty: |

Part Selection

Part: xc/z010clg400-1

< Back Finish

Cancel



Vivado HLS GUI

file Edit Project Sclution Window Help
oS c@al ac k- % |=0 Analysis
o Expgeet L :
| == F||_|:||I'
& Inchudes
1 Source Toolbar Buttons
la Test Benmch —
4 7= solrdont
i @ constrainks
o dinsctivedtel
o scnpiid -
Information
Pane
Project Auxiliary
Explorer Pane
Pane
B Conscls & Errars. & Warnings ! r_—l s s ® ]
COT Build Concode [fr_pr]
Console
Pane
1 ibesm sadeched




Refactoring your C/C++ Code

* See, Github: hls_float_mult.c
e Define an union variable

* Insert pragmas

typedef union ftoi {
float T;
unsigned int u;

b ftoi;

=]

[ I

&

int float mult(float a, float b, float *c)

12 {

13 #pragma HLS INTERFACE s axilite register port=c bundle=slv@
14 #pragma HLS INTERFACE s axilite port=b bundle=slve

15 #pragma HLS INTERFACE s axilite port=a bundle=slve

16 #pragma HLS INTERFACE s_axilite register port=return bundle=slv@
18 static int cycle = 8;

-

28 *c = a * b;

21 cycle++;

22

23 return cycle;

24}



Validate the C/C++ Code

e 4. Click the Run C Simulation button, or use menu Project >
Run C Simulation, to compile and execute the C design.

¢ Vivado HLS 2017.4 - lec_9 (C¥FPGA¥HLS¥lec_9)
File Edit Project Seolution Window Help

9! B« BoX e R EGBS RO P 11 R G )
5 Ex E3 = 8 || lg float_ mult.c EZ | Run C Simulation [
i 1 #include <stdioc.h>

2 #include <stdlib.h>

[ HA -

* 5.In the C Simulation dialog box, click OK.
e The Console pane confirms the simulation executed successfully.

E) Console 22 O] Errors| & Warnings

Wivado HLS Console

fia=9.0a06888 fib=7.38080@ fres=76.919998 fref=78.919998
fia=1.27@8808 fib=4.6780@@ fres=5.932988 fref=5.930080
fia=7.28068808 Tib=8.930888 fres=55.818486 fref=65.818485
fia=6.43068808 fib=4.338800 fres=31.293399 fref=31.295399
fia=8.870880 fib=4.2188@@ fres=33.974781 fref=33.974781
fia=3.1086888 fib=6.178808 fres=19.126999 fref=19.125999
fia=8.13068808 fib=5.l40008 fres=41.733208 fref=41.78520@
[Test Passed]

INFO: [SIM 211-1] C5im done with @ errors.

TMFG: [SIII-\,'I 211_3] B R CSIM -Finish EE e
Finished C simulation.



High-Level Synthesis

* Click the Run C Synthesis toolbar button or use the
menu Solution > Run C Synthesis > Active Solution

* When synthesis completes, the report file opens
automatically

* Because the synthesis report is open in the Information
pane, the Outline tab in the Auxiliary pane automatically
updates to reflect the report information.

=2 9 (C¥FPGA¥HLS¥lec 9)

ution Window Help

PR G R CEREBE RO 3=

.| float_mult.c =| float_mult_csim.log =

Run C Synthesis L

1 INFO: [SIH 2] EE R R R R CSIM start E L L T EEE T

ENF L . FeTes &1 S~ TEd .2 17 Vst e ™ e e - [ ——— -




Performance Estimation

e Check "Performance Estimates" in the Outline tab

* In the Performance Estimates pane, you can see that the clock period is
set to 10 ns. Vivado HLS targets a clock period of Clock Target minus
Clock Uncertainty (10.00-1.25 = 8.75 ns in this example).

* The clock uncertainty ensures there is some timing margin available
for the (at this stage) unknown net delays due to place-and-routing

* The estimated clock period (worst-case delay) is 6.70 ns, which meets the
8.75 ns timing requirement

Performance Estimates

-] Timing (ns)
=] Summary
Clock Target Estimated Uncertainty
ap_clk  10.00 6,70 1.25

- Latency (clock cycles)
=] Summary

Latency Interval
min  max min max lype
4 4 4 4 none



Utilization Estimation

* The resource utilization numbers are estimates
because RTL synthesis might be able to perform
additional optimizations, and these figures might
change after RTL synthesis.

Liilization Estimates

-] Summary
Mame ERAM_18K DSP48E  FF LUT
DSP - - - -
Expression - - 0 39
FIFC - - - -
Instance 0 3 325 617
Memory - - - -
Multiplexer - - - 33
Register - - M0 -
Total 0 3 A7 ]
Available 120 g0 35200 17600

LHilization (%) 0 3 1 3



Interface Report

* The Interface section shows the ports and /O
protocols created by interface synthesis

Interface
RTL Ports Dir Bits Protocol Source Object C Type
s axi_sh/0 AWVALID in 1 5 Al AV pointer
s axi_sh/0 AWREADY out 1 S axi AN pointer
¢ axi_sh/d) AWADDR In f 5 axl AR pointer
¢ axi_sh/0 WVALID in 1 5 axi AN pointer
s axi_slv0 WREADY  out 1 5 _axl sl pointer
5_axi_shv0 WDATA in 32 5 _aAxi shv pointer
z axi_sh-0 WSTRB in 4 5 axl AR pointer
¢ axi_sh0 ARVALID in 1 5 A AN pointer
¢ axi_sh0 ARREADY out 1 5 Al AV pointer
s axi_sh/0 ARADDR in f 5 ax sl pointer
s axi_shv0 RVALID out 1 5 _axl v pointer
5_axi_shv0_RREADY in 1 5 ax] v pointer
z axi_shv0 RDATA out 32 S Al AV pointer
¢ axi_sh/0 RRESP out 2 5 axi AW pointer
¢ axi_sh/0 BVALID out 1 5 axl AR pointer
s axi_shs0_BREADY in 1 5 axi AN pointer
5_axi_slv0_BRESP out 2 5 _a@x] sl pointer
ap_clk in 1 ap_ctrl_hs float_mult return value
ap_rst_n in 1 ap.ctrl_hs float_mult return value
interrupt out 1 ap._ctrl_hs float_mult return value



|IP Creation

The final step in the High-Level Synthesis flow is to

package the design as an IP block for use with S—

other tools in the Vivado Design Suite

1. Click the Export RTL toolbar button or use the
menu Solution > Export RTL

2. Ensure the Format Selection drop-down menu
shows |P Catalog

3. Click OK. The IP packager creates a package for
the Vivado IP Catalog

4. Expand Solutionl in the Explorer

5. Expand the impl folder created by the Export
RTL command

6. Expand the ip folder and find the IP packaged as
a zip file, ready for adding to the Vivado IP Catalog
(See, right)

v =5 lec o
kit Includes

= Source
lg float_mult.c

flim Test Bench
v = solution?

i constraints
== csim
v (= impl
v = ip
=| autcimpl.log
= auxiliangxmi
|| componentxml

5 float_mult_info.xml

[#] pack.bat

o run_ippack.tcl
g tmpxpr

=| vivado.jou

E wiline_com_hls float_mult_1_0.zi

88 Constrainis
&= bd

= dnoc



Import to IP Catalog

* Create a new project on Vivado, then create a block design
* Project name as "hls_walk through 1"
e RTL project, no add sources, constraints, and specify your Zybo board
* Make sure the constraint file "Zybo-Z7-Master.xdc" is loaded

e Click an "IP Settings..." on a diagram, then open a project
settings window

Diagram

Right click on a "Diagram"

+ agdp. v = button to add IP.
Add Module...
IP Settings...

[¥ validate Design



Add a Path to IP Repositories

* Add a path to Repository manager for the IP generated on Vivado HLS
* In the tutorial, the IP path is "C:/FPGA/HLS/lec_9/solution1/impl/ip"
* Make sure your "Float._ mult" is Ioad__ed

4F Float_mult (xilinx.com:hls:float_mult1.0

Recent | = CJFPGA v 2 0O= K, BE XD R

1
| ¢
IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IF to a selected '
Ceneral repository. If an IP is disabled then a tool-tip will alert you to the reason.
.
Elaboration sitories ’ -
Synthesis
Implementation
Bitstream / o 1 repository was added to the project
~ 1P
Mo tent
Repository
PETrTTe )
Repository
Toms otiae Refresh Al > IFPGAHLS/lec_g/solutionAimpli
l - g
Praject s Lo L ec_disolunonamplip
=i - v |IPs (1)
¢ IP Repositories =

|  Directory: | C\FPGAHLSVec_S\solutiontimplip
o Lok
¥ solutiont e OK

.autopilot

>
> tcls
> csim
~ impl
~ ip
> Hil

L

'\'_"J | Cancel | | Apply | | Restore... |



System Generation

* On Block Design, instance a "ZYNQ7 Processing System"
* Then, also instance a your IP core "float._mult"

* Next, concatenate with them (Processor System Reset and AXI
Interconnect are inserted automatically)

Diagram X Address Editor X

@ a X ® Q + ¥ C g

* Designer Assistance available. Run Block Automation(CRun Connection Automation

rat_ps? _0_50M

float_mult_0 Hei b fesct =
il resd in s S rescod]
S|4 s_axi_AXILiteS N auon rezct peripherl rascqon]
H Vivade™ HLS = mb_dobig @ys st Inficroonnecf anceein|i00]
" + A i = o ok perlphoral _ancs anf0i]
il ‘ ) Froce == Sy=wm Resa i
ap_rst n

Float_mult (Pre-Production)

procassng_system7_0

processing_system7_0 FEDEDE I H
- wano o + ||
DDR + ||| m_s s ek PN o s 0 4 [
- FIXED_IO +||| T
M_AXI_GPO_ACLK M_AXI_GPO + FOLE, RESETO M fle—
ZYNQ FCLK CLKO ZF HOT Procesang Sysbem

FCLK_RESETO_N

ZYMNQT Processing System




Generate Bitstream

To re-use HDL design flow, do following steps:

1. Right-click on "design 1", and select "Generate Output
Products...", then "Generate"

2. Again, Right-click on "design_1", and select "Create HDL
Wrapper...", then "OK"

- Design Sources (7
.1 design_1 (design_1 hdy
» Constraints Source Mode Properties...

A Simulation Sources (1 @ OpenFile

>l sim_1 (1 & Create HDL Wrapper... D

Yiew Instantiation Template
& Generate Dutput Products... >
Feset Qutput Products...




Synthesis Hardware and Export

hello_world_1 - [C/FPGASlec2_1/hello_world_1/hello_world_1.xpr] - Vivado 2017.4

/’

File

Click "Generate Bitstream", then "Yes" n

and "OK"

After finish bitstream generation, then

"Cancel"

In "Menu",

select "File" and "Export",

then "Export Hardware"

Check "Include bitstream", then "OK"

Open Journal File

FrTTTTSOTE

Edit Flow Tools Window Layout Wiew Help

» o
Mew Project... " Bog X '
Open Project... JCK DESIGN - design_1
Open Recent Project 3
COpen Example Project... purces
Save Project As... A= 5+
Write Project Tcl... Design Sources (1
Archive Project... > B4 design_1_wrapper (design_1_
Close Project Constraints

Simulation Sources (1
» sim_1(1

Save Block Design As...
Close Block Design
Open Checkpoint...
Mew IP Location...
QOpen IP Location... 5 ) i

lierarchy | |IP Sources Libraries i
Mew File... wrce File Properties
Open File... design_1.bd
Open Recent File 3
Open IP-KACT File... ¥ Enabled

_ocation: CiUFPGANlec2_1/hello_we
Add Sources... lype: Block Designs
Qpen Source File... Rart: XC72010clg400-1

QiTa E2 A KR
Export 3 Export Hardware. ..

54R PM

Launch SDK Export Block Design...
Open Log File Export Bitstream File..

Export Simulation...
STl Repol



Developing SW

e Launch SDK on Vivado

* From the SDK File menu, select New >

Application Project.

a. In the New Project dialog enter the
project name "zyng_float_mult"

b. Click Next.

c. Select the "Hello World" template.

d. Click Finish

@ Mew Project

Application Project

Create a managed make application project.

Project name: | zyng_float_mult

Ilse default location

CNED A

C¥FPGA¥Vivado¥hls_walk_though_1¥hls_walk_though_1.s

default

(5 Platform: | standalone

Target Hardware

Hardware Platform: | design_1_wrapper_hw_platform_0

Processon ps{_cortexad_0
Target Software
Language: ®C OC++
32-bit
MN/A

dh

|| Mew...

Board Support Package: (@) Create Mew | zyng_float_mult_bsp

LIse existing

Cancel




Execute "Hello World" SW

e Power up the Zybo board and test the Hello World
application

 Ensure the board has all the connections to allow
you to download the bitstream on the FPGA device

e Click Xilinx > Program FPGA (or toolbar icon)

5] SDK Log 52 EE = O
@1:58:38 INF : XSCT server has started successfully. A
@1:53:48 INF : Successtully done setting XSCT server connecticn chz

@1:58:48 INFO : Processing command line option -hwspec C:/FPGA/Vivac
@1:58:48 INFO : Successfully done setting SDK workspace

@2:17:15 INFO  : Connected to target on host '127.8.8.1"' and port '31
@2:17:17 INFO
82:17:18 INFO

: 'targets -set -filter {jtag cable name =~ ElgllEﬂ*

<:I::EEE:Ecnf1gu ed ;ucce:;full; with bitstream "C: :jﬁi::::>




Cont'd

* Click on SDK Terminal and click on add button to add a port to the
terminal

a. Click the Connect icon (See, bottom)

b. Select Connection Type > Serial.

c. Select the COM port to which the USB UART cable is connected
d. Change the Baud Rate to 115200

e. Click OK to exit the Terminal Settings dialog box.

Pef_dil_1 yeErneri
<

Chverview | Source

3 [#lPr. ElTa. BC. [OPr. EsD. 22| = B [E]SDKLog &

== ! Bl:58:38 INF
B1:58:48 INF

Connect to serial port. § INF
' Bl:38:48 INF
@2:17:15 INF

B2:17:17 INF

@2:17:18 INF

[}

[ ]

[ ]

[}

[ ]

[ ]

[}

|| Send | | Clear Py




Terminal Settings Dialog

* Right-click the application project "zyng_float. mult" in the Explorer panel

a. Click Run As > Launch on Hardware.

e Switch to the Terminal tab and confirm that "Hello World" was received
e Or, you can use TeraTermianl (Windows) GtkTerm (Ubuntu)

|& ps7_init.c
ps7_init.h
@ psT_inithtml
=| ps7_init.tcl
|5 system.hdf

v % zyng_float_mult
;}jf Binaries
& Includes
= Debug
&= src

(Hl; zynq_float_mult B

X

E

_ﬁ. Target Connections

(= Hardware Serve
(= Linux TCF Agen
(= QEMU TefGdbC

MNew

Go Into
Open in New Window

Copy
Delete
Source

Rename...

Import...
Export...

Build Project
Clean Project
Refresh

Close Project

Close Unrelated Projects
Build Configurations

Run As
Debug As
Compare With

Target Information

This Board Support Package is compiled to run on the following target.

Hardware Specification: C¥FPGA¥Vivado¥hls_walk_though_1¥hls_walk_though_1.s
Target Processor: ps7_cortexad 0

»

Cerl+C
Crl+V

Delete

F2

F5

age OS5,

andalone
5

rofiling, abort and exit.

tandalone w6 5

e Board Support Package.

It_0 float_mult
ffi_0 generic
fi_1 generic

at 115200

TLF

E sD...

® = 8
w XL

~

[ 2 Start Performance Analysis

TEF

tandalone is a simple, low-level software layer. It provides access
terrupts and exceptions as well as the basic features of a hosted

SDK Log £2

8l1:
el:
8l1:
el:
82:

£ 1Launch on Hardware (System Debugger)

58:38
58:40
58:48
58:40
17:15

£ 3 Launch on Hardware (System Debugger on QEML)

INF(
INF(
INF(
INF(
INF(

=l * S i L —h

Already connected to port: COMB8Hello World

Send

Clear



Modity SW to Communicate with
Your |IP Core

* The "float_mult" function has "a" and "b" as inputs

and "c" as an output

* Following processing exists in the APl generated by
Vivado HLS
* Setvalue to a
e Setvaluetob
* Read the value of ¢

* [n order to control the hardware, there is an API
that performs the following processing
* Start operation
 Terminate of calculation



APls for a Generated IP Core

 The IP core APl is stored in the following directory (in this
example)

design 1 wrapper_hw platform_0/drivers/float top v1 0/
data/src
* |In the directory, the following files are stored
* xfloat_top hw.h
e xfloat _top_linux.c
e xfloat _top_sinit.c
» xfloat top.c
e xfloat top.h

* The detail of the defined APl is described in "ug902-vivado-
high-level-synthesis.pdf"




SW Code for an ARM Processor on Zybo

* See, Github: sw_code.c

Status = XFloat_mult IsIdle(&XFT);

#include <stdic.h>

#include "platform.h” for (i=8;i<18;i++) {
#include "xfloat mult.h” printf("TEST LOOP Hd:\n",i);
#include "xparameters.h” ref_a.f = (float)i;
= S T e
- typedef union ftoi { r"E'!"_h.'F = (float)(i*1ee + 1i); . .
float ; while(!XFloat_mult_IsReady(&XFT)) ; // Check Ready Signal
unsigned int u; XFloat mult Set a(&XFT, ref_a.u); // Set register a
b ftoi; XFloat mult Set b(&XFT, ref b.u); // Set register b
. in_a.u = XFloat_mult_Get_a(&XFT);
// from xparameters.h . - - -
#define XF_DEVICE_ID  XPAR_FLOAT MULT_@ DEVICE_ID in_b.u = XFloat_mult_Get_b(&XFT);
printf(" Get wvalue a = ¥f(¥x), b = ¥ (¥x)\n",
XFloat_mult XFT;// Instance for Wivadg HLS Generated IP in a.f,in a.u,in b.f,in h.uj;
- KFloat_mult_Start(&XFT); J/ Start HW
/7 Testbench . ‘] 1_ 1 ax . T . 1
=~ float ref float_mult( float a, float b) while (!XFloat_mult IsDone(&XFT)) ; // Wait Done signa
1
return a * b out_c.u = (unsigned int)XFloat_mult_Get c(&XFT); // Load register c
b cycle = XFloat_mult_Get_return(&XFT);

= int main()

r printf("#d: Get wvalue c = ¥f(¥x)\n", cycle, out_c.f,out_c.u);
int i,Status;
XFloat_mult_Config *ConfigPtr;
;:D% TEf—a’.FEfTb’ out_es if { ref_float_mult(ref_a.f, ref_b.f) != out_c.f ) // Compariscn

oi in_a, in_b; . — — — — —
int cycle; printf(" ERROR! ref = ¥f, val = ¥f\n",
ref_fleat mult({ref_a.f, ref_b.f),out_c.f});
'/ Initialization }
init_platform();

XFloat_mult_Initialize( &XFT,XPAR_FLOAT MULT_@ DEVICE_ID); . " "
printf("fleat_mult test done.wn");

ConfigPtr = XFloat_mult_LookupConfig(XF_DEVICE_ID); cleanup_platform();
Status = XFleoat_mult CfgInitialize(&XFT, ConfigPtr); return @;
if (Status != XST_SUCCESS) { }

return X5T_FAILURE;

i
Status = XFloat_mult_IsTdle(&XFT);




Execution Results

T Tera Term - [FEE)|VT
Jr4AF) |E(E) FES JXFO-JHO) 242F2W) AJLTH)

Get walue a = 3.00000004040000070, b
Get walue o = 909, 000000 3

et value ;
he et va
TEST LOOP &:
Get walue z
16: Get wvalue ¢ =
TEST LOOF &:

Get walue a = B.000000C4C

17: LGet value ¢ = 36
TEST LOOP 7:

et walue a = 7.000000C40.

19:
TEST LOOFP 9:
Get walus a = 9.0000000417
200 Get walue c = 81871.0000001 45
tloat_mult test done.




summary

* HLS brings value to the FPGA design:

* Make hardware design easier for hardware engineers

* Allow software engineers to design hardware and reap
energy/performance benefits

* Benefits: Productivity, lower non-recurring
engineering costs, maintainability, faster time to
market

* Execute a tutorial through a floating point precision
multiplication



Exercise

Mandatory) Describe the advantage and the
isadvantage for the high-level synthesis based
esign comparing with the RTL based design

(
C
C
(Mandatory) Execute a tutorial for a floating point
precision multiplication on your Zybo board

 (Optional) Compare with non "#pragma HLS
pipeline" version, and report differences of
pipelined one

Send a report to nakahara@ict.e.titech.ac.jp

Deadline is 24t™ July, 2018 (At the beginning of the
lecture)



